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About PocketMoney®
Simple, elegant, and powerful - PocketMoney tracks your finances quickly and accurately.
PocketMoney has been an leader and innovator in the mobile computing industry.
Starting with the Apple Newton OS over 17 years ago, on through the Palm OS and
Pocket PC.
PocketMoney brings all that experience to the iPhone, and builds on the elegance and
power of the iPhone platform to give our users the best user experience ever.
•
•
•
•
•
•
•
•

Track an unlimited number of accounts.
Repeating and split transactions.
Generate expense reports & pie charts.
Auto-complete transaction based on Payee.
Turn on multiple currency support if you are frequent traveler.
Built in backup and restore over local Wi-Fi network. (Requires SyncDocs)
Import and export QIF files over local Wi-Fi network. (Requires SyncDocs)
Several languages supported.

Support User Forums:
http://www.catamount.com/forums/
Support E-mail:
support@catamount.com
(I use SpamArrest to deal with spam. You will receive an email asking you to confirm
that you are a human.)
Copyright & Trademark:
©1994-2011, Catamount Software.
PocketMoney is a registered trademark of Catamount Software.
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0. Getting Started
If you are just starting out trying to get your finances under control it can be a daunting
task so Iʼm adding this Getting Started chapter for you. If you have used desktop financial packages or other handheld packages before the you can skip again to the chapters
that interest you.
Where to start? Letʼs start with What, Who & Why, then When, and end with How.
What, Who & Why
Once you leave your parentʼs house you canʼt avoid dealing with money from buying the
necessities of life food, shelter, clothing, or your having fun money.
People track their finances for various reasons. A family might need to get their spending under control, a self-employed business owner might track spending to maximize
their deductions at the end of the year for tax purposes, or a you might want to tighten
your spending in some areas so you can budget to save money for buying big ticket
items like a car or house. Everyone is different, but money works the same.
Using an application like PocketMoney allows you to track both your account activity so
you donʼt bounce your checks or exceed your credit limit both of which can lead to additional fees. When strapped for cash, additional fees and charges is the first thing you
want to avoid. The second thing to avoid is spending money on unnecessary expenses
which creating a budget and sticking to it. A budget is like Weight Watchers Diet it gives
you guidelines for your spending to help you control your costs, but also lets you still
have a little fun in your life so you can budget to go out to the movies occasionally, just
as long as you donʼt overdue it.
When
Some users save all their receipts and enter them once a week, others enter them in
the checkout line as soon as the transaction happens, and others user a desktop application like Quicken and download their data to PocketMoney so they can have their
data with them on the go. Youʼll figure out what best works for you.
I suggest entering the transaction as soon as you can. This gives you the most up-todate view of your financial state. If you wait until the end of the week, you are more
likely to bounce a check or overdraw your account.
How
There are over 200 features in PocketMoney, but donʼt let the customizability or power
scare you. For basic financial management you only need to use three screens.
1. Accounts Balances screen lists your accounts (checking, cash, savings, visa card).
2. Transaction Register screen list all of your transactions in the account. This is like
your bank statement or checkbook register.
3. Edit Transaction screen shows the details for a single transaction.
7
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When you want to enter a transaction you will select the account to open the account
register, and then tap on + to create a new transaction. Saving the transaction updates
your balances for the account and the budgets if you are using budgets.
Earlier I said, “Everyone is different, but money works the same”.
When you start tracking your finances you need to understand the 3 basic types of
money flow.
• Deposits (credits) increase your net worth. Receiving your paycheck.
• Withdrawals (debits) decrease your net worth. Buying food.
• Transfers shift money between between accounts and therefore have no affect on your
net worth. Transferring money from your checking account to your Visa account to
make your money credit card payment.
The rest of the user manual covers the various features of PocketMoney, and how to
configure them to help you track your money.

1. Account List Screen
The first time you launch PocketMoney it will open to a blank Account List Screen.
Tap the Edit button, and then the + button to create a new account to track.
Edit button

Preferences button

Total worth
checckbox/
binder ring

Balance
Add new transaction

Balance Bar

Action Button/
File Transfers

Account View Options

Edit Button: Switches the screen to the standard iPhone Editing screen. Tap the Plus
sign in the upper right corner of the screen to create a new account. Tap the red circle to
delete an account. Tap on an account name will open the Account Info Screen. Grab8
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bing the mover will let you rearrange the order of the accounts. Show Accounts in the
Account View Options must be set to All for the rearrangement grabbers to appear.
Preferences button (Prefs): Opens the PocketMoney Preference screen. This is also
PocketMoney In App Purchase Add-ons can be purchased to activate more features in
PocketMoney such as Net Worth Chart or Photo Receipts.
Account name: Tapping on the Account name will open the Transaction Register
screen for that account.
Total Worth Button: Toggling the binder ring (or checkbox) ON or OFF affects which
accounts are included in the total balance in the balance bar. This can also affect the
data used for Budgets and Report if sShow Accounts is set to Total Worth in the Account
View Options screen.
Add new transaction button: Tapping on this button will create a new transaction and
open the Edit Transaction screen to allow you to edit it...use this shortcut to save a couple steps to quickly create a new transaction for a specific account.
Balance bar: Displays one or two options for the balance. Show one or two balances in
the balance bar by turning ON the “Second Balance Line” in the Prefs > Display Options
Tap on Current Balance, Cleared Balance, Available Credit, Available Funds, or Future
Balance to cycle through the balance types.
Future Balance - The balance including all future transactions entered. If you post date
a transaction, it is grayed out in the transaction register, but Future Balance will include
it in its Balance. You could also call this the Absolute Balance or Overall Balance.
Cleared Balance - The balance of the cleared transactions. Check the cleared checkbox
of a transaction in the Transaction Register to change this balance.
Current Balance - This is the balance as of Today. This balance does not include future
transactions.
Available Funds - The balance available for you to withdrawal from your bank account
or spend on your credit card before you are overdrawn or exceed your credit limit.
Available Balance is the difference between the Current Balance and the Limit entered
in the Account Info for the current account.
Available Credit - The balance available for you to spend on your credit card or credit
line account before you exceed your credit limit.
Action button: Opens the Wi-Fi File Transfers action sheet.
For more display options see the section on Display Options > Accounts.
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2. Account Info Screen
Account Info Screen is where you set general settings for a particular Account. Only the
account name is required. The rest of the fields are optional.
Back (PocketMoney) button: Returns you to the
previous screen.
Account name field: This must be filled in when you
create a new Account. This name is what is displayed
on the Account List and Account Transaction screens.
Type: The type of the account. The options are Asset,
Cash, Checking, Credit Card, Credit Line, Liability,
Money Market, Online, Savings.
These types are based on the types specified in the
Open Financial Exchange standard. If you are using
QIF files to import/export data then Bank includes
Checking, Credit Line, Money Market, and Savings.
By default Bank = Checking..
The Online type doesnʼt display a balance in the Account List screen, but will instead open to the website
entered on the website line. So, I might have a PayPal account setup to launch the
http://www.PayPal.com so I can access my online account from within PocketMoney, keeping all my accounts in one place. [*Please note: this is NOT online
banking where you can download your statements or
electronic banking from PocketMoney. You are actually logging into your account through a web browser
just as if you were using Safari.]
Icon: Tapping anywhere in the Icon cell will open the
Icon Picker. Pick one of the icons that come with
PocketMoney, or a custom icon if you installed any.
(*See Installing Custom Icons in the Miscellaneous
Chapter.)
Expires, Account #, Institution, Phone, Notes: Optional fields for specific information
on your accounts. The Notes field is a free form field that allows you to enter longer
amounts of data about the account. You could put the bank address or the wire transfer
information in Notes.
Phone and Website info button: Tap the blue arrow to open to dial the phone number
or open the website.
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Website: If you set the type to Online, then this needs to be set to the url that you use
to connect to the online banking at your institution.
Fee: The Fee field is used on the Edit Transaction screen if you tap the +Fee button.
You might want to set the fee if the account has a service fee for withdrawing money
from ATMs. This saves you data entry since you can enter the ATM withdrawal, then tap
+Fee to quickly add a new transaction with the foreign ATM fee amount. If you receive a
lot of wire transfers, then you could set this for the wire transfer fee.
Limit: This holds the minimum balance if the Type of the account is Bank, Cash, or Asset, and holds the credit limit if it is a Credit Card or Liability account. Leave Limit blank
if you do not want PocketMoney to highlight your account balances red if you exceed or
fall below the limit for the account. Limit is also used to calculate the Available Balance.
Chk#: The next check number to use when +123 button is tapped on the Edit Transaction screen.
Currency: If Multiple Currencies is ON in the
PocketMoney Preferences, then you can set a currency for individual accounts. Picking a currency
from the Currency Picker will also update the Exchange Rate with the current exchange rate from
the web.
New currencies have been added called “Noncurrency currencies” for user who use the program
to track frequent flyer miles, award points, billable
hours.... These custom currencies will display as:
Hours - “hr 32.4”
Days - “d 6.2”
Miles - “mi 20593”
Kilometers - “km 12303”
None - “1234”
Exchange Rate: The exchange rate per one unit of your home currency.
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3. Transaction Register Screen
Tapping on an account in the Account List screen opens the Account register screen.

Back button: Returns you to the previous screen.
Search button: Displays the search entry field and the
Pending, Cleared, All quick filter buttons. Enter a value to
show transactions that match the entered criteria. Pick
Pending, Cleared, or All to display that set of transactions.
Searching on amounts...
<#: matches transactions less than value. (Enter <-300 to show all withdrawals over
300)
>#: matches transactions greater than value. (Enter >300 to show all deposits over 300)
#...#: matches all transactions between the two values. (Enter -300...-500 to show all
withdrawals between 300 and 500)
New button: Creates a new Transaction.
Cleared Checkbox: Marks the transaction as cleared.
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Balance as of Transaction Date: The balance at the transaction date. Also known as,
the running balance or the future balance at a particular date. If you post future transactions, then this will show you the balance for your account as of the date of that future
transaction. This can be toggled on or off in the Prefs > Display Options > Transactions
> Current Balance ON/OFF.
Swipe to delete row: Drag your finger from left to right on a row to display the red Delete button so you can delete the transaction.
Reports button: Opens the Reports Selection Screen to access the Account, Category,
Class, and Payee reports.
Tools button: Opens the Tools Screen which includes file transfers, go to date, account
adjustment, mark all items cleared, and rollup options. (See Transaction Register Tools
for more info.)
Filters button: Opens the Filters screen to create custom filters. (See Filters section for
more information.)
Go To Date button: Displays a date picker so you can quickly jump to that date. If you
have a lot of transactions this is quicker than flipping the screen back to 2002.
HINT: To quickly get to the first transaction flip the year to something really early like
1978...to quickly get back to the newest transaction flip the year to something in the future like 2020.
Action button: Opens the Wi-Fi File Transfers action sheet. This also includes the Email option so you can email the currently viewing register. (See Wi-Fi Backup, Restore,
Import, Export for more info.)
View button: Opens the Transaction Register View Options Screen. Pick what fields to
show in the transactionʼs row. Change the ordering of the transactions (ascending/
descending).
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4. Edit Transaction Screen
Tapping the New button on the Account List screen
will create a new transaction and opens the Edit
Transaction screen.
PocketMoney provides three types of transactions
using the Data Entry Slip:
• Deposit - from sources outside PocketMoney. Deposits are any transactions that increase your net
worth, such as depositing your paycheck into checking, or depositing an inheritance from Aunt Gertrude
into your savings account.
• Withdrawal - to payees outside PocketMoney.
Withdrawals are any transactions that decrease
your net worth, such as writing a check for your
electric bill, spending $10 at the movies, or using
your credit card to purchase a new snowboard.
• Transfer - from one PocketMoney account to another. Transfers do not change your
net worth because money is just being moved between accounts. Examples include
withdrawing cash with your ATM card (into Petty Cash), or writing a check to pay your
credit card.
Save: Saves the transaction and returns you to the previous screen.
Cancel: Cancels any edits youʼve done and returns you to the previous screen.
Withdrawal/Deposit/Transfer: The transaction type selector sets the type of the transaction. If you press Transfer when the Transfer To account is empty, then it will prompt
you for the account to transfer money to.
Withdrawal - to payees outside PocketMoney. Withdrawals are any transactions that
decrease your net worth, such as writing a check for your electric bill, spending $10 at
the movies, or using your credit card to purchase a new snowboard.
Deposit - from sources outside PocketMoney. Deposits are any transactions that increase your net worth, such as depositing your paycheck into checking, or depositing an
inheritance from Aunt Gertrude into your savings account.
Transfer - from one PocketMoney account to another. Transfers do not change your net
worth because money is just being moved between accounts. Examples include withdrawing cash with your ATM card (into Petty Cash), or writing a check to pay your credit
card.
14
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Note: Transfer transactions are saved as two separate entries; one transaction for the transfer from account and one
transaction for the transfer to account. Any modifications made to one half of the transfer are made intelligently to
the second half.

Date: Date of transaction. Tapping the Date label or date will open the Date Picker. Tapping on the Blue Disclosure Button will open the Repeating Transaction Editor. If the
transaction is a repeating transaction then the date will be orange in color.
Payee (To/From/Transfer To/Transfer From): Tapping the Payee label or > will open
the Payee Picker. With a new transaction PocketMoney tries to auto-complete the
transaction for you.
Auto-Complete - Looks backwards through your transactions trying to match the Payee
field you are currently entering. If it finds a match then it intelligently fills in the other
fields. (It wonʼt replace date or amount if you already changed them.) If you tap delete
then it will erase any auto complete that it entered. Tap Next to finalize the auto complete.
If a Category is entered, and you open the Payee Picker, then the Payee Picker will
show only Payees for that Category by default. At the bottom of the Payee picker is a
selector. Pressing All will show All Payees.
Amount: The amount you spent or received. Tapping on the Amount label or > will open
the Exchange Rate Worksheet if Multiple Currencies is on in the PocketMoney Preferences. (See Exchange Rate Worksheet for more information.)
ID#, Cleared, Memo & Class: Optional fields. You can turn their display off in the View
Options.
Category: Turn on “Category above Payee” if you want Category positioned like
PocketMoney for Newton, Palm OS, and PocketPC positions Category.
If a Payee is entered, and you open the Category Picker, then the Category Picker will
show only Categories for that Payee by default. At the bottom of the Category picker is
a selector. Pressing All will show All Categories.
++ Duplicate button: Duplicates the current transaction.
Splits button: Opens the Edit Splits screen. If the transaction is already has splits
transactions, then the category will be displayed as <--splits--> and you can tap on <-splits--> to access the Edit Splits screen, too.
+Fee: Creates a new transaction with the Fee specified in the Account Info for this
account.
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Camera button: If you have purchased the Photo Receipts add-on then the camera
button will appear, and you can attach up to 3 photos to a transaction. This is useful if
you want to keep electronic records of your receipts or warranty papers.
Trash Can: Deletes the current entry.
Next Check #: Inserts the next check number into
the ID# field. This option shows in the keyboard toolbar only when the keyboard is displayed for the ID#
field.
Contacts: Opens Contacts to allow you to pick a
payee out of your Contacts application. This option
shows in the keyboard toolbar only when the keyboard is displayed for the To/From field.
View Options: Prefs > Display Options > Edit
Transaction is where you can toggle the display of
the Payment, Notes, Class, and Cost/Gal fields on or
off. (See Edit Transaction View Options for more
info.)

5. Split Transactions
Splits allow you to breakout a single transaction into several categories and amounts. If you shop at Super Walmart and buy groceries, a new book shelf, and get $40
cash back then you can enter each sub transaction for
your Food:Groceries, Home, and Transfer to Cash.
The split transactions are in the top section of the window.
Tap on an item to edit it.
Splits total: the sum of the split items entered.
Remainder: the difference between the splits total and
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the total.
Total: the overall amount for the transaction. This is the
amount shown on the Edit Transaction screen and in the
transaction register.
+: creates a new split item
+Remainder: creates a new split item with the amount of
the remainder.
Adjust: sets the Total to the Splits Total. If you add new
split items it doesnʼt update the Total automatically so you
can see how much remainder you have left. After you add
the new split items, then tap Adjust to update the Total.
Clear: removes all of the spits items. Tapping Edit will change the Adjusts button to
Clear. Tap Edit and Clear is a quick way to clear out the splits items if the auto-complete
feature fills in a splits transaction when you only want a single category transaction.

6. Repeating Transactions
For transactions that occur at regular intervals you
must let PocketMoney know they are repeating
transactions and when they repeat.
Examples of common repeating transactions are
mortgage, salary, phone bill, and car payments.
Frequency: None, Daily, Weekly, Monthly, Yearly.
To stop a repeating transaction set the Frequency to
None.
Every: Repeat transaction every x days, weeks,
months or years.
NOTE: Bi-weekly, Bi-monthly, Quarterly and other
types of repeating events are easily created by picking setting the Frequency first and then setting
Every to Every 2 weeks for bi-weekly, Every 2
months for bi-monthly, or Every 3 months for quarterly repeating events.
End On: End date for repeating transaction. Set to the end date of your car payments
so it stops repeating when your car is paid off.
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Repeat weekly on: Set the day of the week that Weekly repeating transactions repeat
on. If you buy coffee each morning before work, then check Monday - Friday to have a
transaction for $7 for the super quad grande white mocha with hazelnut from Starbucks
each morning.
Repeat monthly on: Monthly repeating transactions can repeat on the same date each
month (15th of each month), or repeat on a day in the month (3rd Friday).
NOTE: PocketMoney will add repeating transactions each time the application is
launched if there are new repeating transactions ready to be added.

"

"

"

"

Tapping on Repeating Transactions on the main Accounts screen will show all of the repeating transactions across all of your accounts. In the sample above the account is
listed below the amount of the transaction, and the type of the repeating event is listed
under the date.
Tapping the + will create a new repeating transaction, but since no account is selected
you need to make sure you select an account.
Process to Date: Will post any repeating transactions up until the date you pick in the
calendar picker. Use this if you want to post all of your repeating transactions up until
your next pay date.
Note: Once a repeating transaction is posted the date will change to the next time it will
be posted. Deleting the posted repeating transaction from your account transaction register will not move the next post on date back again.
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7. Samples
Initially, all account balances in PocketMoney are zero. The first step in PocketMoney is
creating Opening/Starting balances for all your accounts. Letʼs set up balances for
checking and Visa accounts. These accounts are the defaults built into PocketMoney,
but you can change the name of the accounts and add as many other accounts as you
need.
Starting Balance for Checking
Letʼs create a checking account starting balance of $354.88:
1. Open PocketMoney.
2. Create a Checking Account.
"
a. Tap New button.
"
b. Enter “Checking” in the Account field.
"
c. Tap Back button.
3. Select “Checking” from the Account listing.
4. Tap New button.
5. Set the transaction type to Deposit.
6. Enter “Miscellaneous” into the Category field.
7. Enter “Opening Balance” into the From field.
8. Enter the check number of the last check that you wrote into the Id # field. This enables PocketMoney to assign the next available check number.
9. Enter 354.88 into the Amount field.
10. Tap Save. This will save the transaction.
11. Observe that the calculated balance is $354.88.
Starting Balance for Visa
Letʼs create an unpaid balance in your Visa account of $1,224.69:
1. Tap Back button to return to the Account List screen if you are not there.
2. Create a Visa Account.
"
a. Tap New.
"
b. Enter “Visa” in the Account field.
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"
"

c. Set the Type to “Credit Card”
d. Tap Back button.

3. Select “Visa” from the Account listing.
4. Tap New.
5. Set the transaction type to Withdrawal. (This is money you owe.)
6. Enter “Miscellaneous” into the Category field.
7. Enter “Opening Balance” into the To field.
8. Enter 1224.69 into the Amount field.
9. Tap Save. This will save the transaction. Tap Back button to return to Account List.
10. Observe that the calculated balance is ($1224.69). Parenthesis represent negative
numbers for currencies if your Region in the System Settings is set to United States.
Transfer Transaction
Letʼs enter data for a check to pay your credit card bill:
1. Tap Checking to open the Checking Register.
2. Tap New.
3. Set the transaction type to Transfer.
4. PocketMoney will open the Account picker for which account to transfer money to.
Select Visa.
5. Press the +123 (New Check Number button). The next available number will be entered into the ID# field. Alternatively, you can Enter in a check number.
6. Enter the amount of the check into the Amount field.
7. Tap Save and Back button. Observe that the calculated balance of the Checking and
Visa accounts has been updated to reflect the new check.
Withdrawal Transaction
Letʼs enter data for a credit card purchase:
1. Open the Visa register and tap New.
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2. The transaction type is already Withdrawal.
3. Tap on the Category label or > and select the appropriate category (e.g., Recreation).
4. Enter the name of the store (e.g., Smugglerʼs Notch Ski Shop) into the To field.
5. Enter the amount of the purchase into the Amount field.
6. Tap Save. Observe that the calculated balance has been updated to reflect the new
purchase.
7. Optional: Tap the Memo label and enter information in the Notes field (e.g., Snowboard).
Deposit Transaction
Letʼs enter data for a paycheck deposit:
1. Open the Checking register and tap New.
2. Set the transaction type to Deposit. Your paycheck increases your net worth.
3. Enter the name of your employer (e.g., E. Scrooge) into the From field. The next time
you enter a paycheck you can select the name out of the pop-up list because “Auto-add
to popups” is turned on in the Prefs, or you can enter “E” and PocketMoney will auto
complete the rest of the transaction for you entering the category and amount of the last
paycheck you received.
4. Tap on the Category label and select Salary.
5. Enter the amount of the paycheck into the Amount field.
7. Tap OK and observe that the calculated balance has been updated to reflect the new
deposit.
Transaction in Foreign Currency
Letʼs enter data for a credit card purchase in a foreign country:
1. Turn on Multiple Currencies in the Prefs screen.
2. Open the Visa register and tap New.
3. Tap on the Category label and select Food.
4. Enter the name of the restaurant into the To field.
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5. Enter the amount (in foreign currency) of the purchase into the Amount field.
6. Tap on the Amount label or > to open the Exchange Worksheet. Enter the current exchange rate in the Rate field. For example, if 1.33 is the current exchange rate between
Canada and the US then 1.33 Canadian dollars (foreign currency) equals 1 US dollar
(base currency for account), or pick the foreign currency symbol by tapping the > on the
foreign currency line and pick the currency that you want to use. If you have an internet
connection available, then PocketMoney will lookup the current exchange rate for that
currency code.
7. Tap Save and observe that the calculated balance has been updated to reflect the
new purchase.
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8. Budgets
Creating a budget and sticking to it can really help you get your finances under control.
You will want to figure out what your budget is for each category your track. You can
budget on a daily, weekly, monthly, quarterly, or yearly basis – PocketMoney lets budget
your computer expenses on a yearly basis, entertainment weekly, auto monthly, and
coffee on a daily.
Main Budget Screen
The main budget screen has a lot of information on it, and a lot of options.

< >: Arrow buttons move you to the next or previous time period.
^v: The section headers can be collapsed if you only want to
see the summary amounts.
Budget Period Picker: Displays a picker to choose what time
period to analyze your budget over: Daily, Weekly, Bi-Weekly
Monthly, Bi-Monthly, Quarterly, Half-Year, or Yearly.
Green is good: The green spending bar grows from left to
right as you spend money in the various categories.
Red is bad: If you exceed the budget for the period, then the
bar will continue to grow, but it will grow in red showing how
much over budget you have gone.
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Balance, Available, Budget column heading: Tapping this column heading will toggle
the data displayed in the left column. Balance is how much you have left to spend in
that category or how much over you are. Available is how you have left to spend, but
shows $0 if you are over budget. Budget is the amount you budgeted for the category.
Saved/Deficit, Beat Budget/Missed Budget: Tapping this button toggles between the
Saved/Deficit and Beat Budget/Missed Budget display for the total.
Saved/Deficit - is a simple calculation of expenses for the period minus income for the
period.
Beat Budget/Missed Budget - is how much you beat or missed your budget by. If you
didnʼt meet your budgeted income, then the amount you missed by is counted against
you.
iBeam: Whenever you are viewing the current budget period the yellow iBeam is displayed to show how far into the budget period you are.
Budget Options:
!
Budget Start Date: set a custom budget start date if you budget based on something other than the first of the month.
"
Sort on: list your budget line items by category, actual, budgets, or percentage
spent.

Edit Budget Screen
Tapping the Edit button will switch to the Edit screen for
budget categories.
Delete: tap the red circle to delete a budget category. You
will be prompted to delete the category from the budget
only or from the budget and the popup category list.
+ : tap the add budget category button to create a new
budget category.
Tap on any budget category row to edit the budget category information. Any category that doesnʼt have a budget
associated with it is listed under Unbudgeted.
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Budget Type: Expenses or Income
Period: Daily, Weekly, Monthly, Quarterly, or Yearly
Budget Amount: The amount for the period you
specify.
Include subcategories: If the category has subcategories, then this option will appear. Subcategories are defined as <parent category>colon<sub
category name>. For example, “Food” is the parent
category to “Food:Dining” and “Food:Groceries”.
If Include Subcategories is ON, then the budget
item will include all spending by the subcategories.
If you turn this on for a parent category, then you
should not budget for the subcategories individually.
If Include Subcategories is OFF, then the parent
category will only total expenses that are specifically spent in the parent category.

9. Reports
Reports help you analyze your data.
Report View Options button:
Options to sort the report data by item name, amount, or
count. Also letʼs you change the type of report displayed to
a bar chart if you have purchased the Charts add-on.
List Report:
Turn off the checkbox to remove the item from the Expense total.
Tap on “Charity” in the list to open a Transaction Register
to see what is included in “Charity”. This lets you drill
down into your data so you can run a Category Report,
then drill down into Charity, and run a Payee Report to get
a Report summarizing where you spent your money on
Charity.
Reports summarize any categories that have subcategories associated with them so by drilling into “Food” you will see all “Food:Dining” and
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“Food:Groceries” categories and then you can run another category report to see how
they breakdown.
Pie Chart:
Either one or two pie charts will be displayed. If you have both expenses and incomes in
a single report then two pie charts will be shown to show the breakdown of all expenses
and another for all incomes.
Tap on a wedge in the pie chart to move the report to the details for that wedge piece.
Period Picker: The period picker and arrows allow you to display the report over different units of time from month, bi-month, quarter, half-year, yearly, and all.
Chart Add-Ons:
Chart add-ons are an additional cost and bought through the in-app-purchase mechanism found in PocketMoneyʼs Preferences > PocketMoney Add-Ons screen. The additional chart features are Net Worth, Cash Flow, and Month-By-Month.
Net Worth:

The net worth at the end of each month. This includes all accounts that have the Total
Worth switch set to ON (checked on the account list screen)

Cash Flow:

Inflows and outflows of money in all accounts currently being viewed.

Month-By-Month:

This option under Reports in your Transaction Register summarizes the data by month.
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10. Filters
Filters allow you to restrict the data displayed in the transaction register by several criteria. Setting the filter lets you customize the data used in your reports or exporting transactions to your desktop computer.
Filters Screen
There are two locations to access the saved filters.
On the main Accounts Screen under Custom... is a
Filters option, and at the bottom of the Transactions
Register Screen is a Filters button.
PocketMoney saves the last filter you used when
you leave the Transaction Register so you can continue from where you left off.
If you want to view all the transactions in the register,
then you need to tap Filters button and select Reset
filter.
Selecting a row will active that filter. Current filter is
the currently active filter.
Tapping on the
opens the Edit Filter Screen so
you can modify the filter criteria.
Tapping the + will create a new filter.
NOTE: PocketMoney intelligently displays User Define Filters. If you open the Filters
screen from the transaction register of an account, then it will only show you the filters
available for that account – this includes filters for “Current Account” . If you open Filters
from the Accounts screen then all saved filters will be displayed.

Edit Custom Filter Screen
Set the options to create a custom views of data for reports or for exporting. There is an
All option for each item, including Accounts which is how you can create reports that
span accounts.
Accounts Options: Accounts has a couple special options.
All Accounts option is limited by what the Account View Options has set for the NonZero or Total Worth Accounts. If you really want All Accounts, then make sure Account
View Options is also set to All Accounts.
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Current Account option allows a filter to be created
and applied to whatever the current account is. If
you are in your business checking account register
and active the filter shown in the figure to the right,
then all transactions that have been changed since
the last import/export will be displayed. If you
switch to your personal checking account and active this filter, then all transactions that have been
changed since the last import/export will be displayed for your personal checking account.

Dates Options: Dates has two new options in version 2.0.
Custom... lets you pick a specific range of dates to show.
Selecting Custom... opens the screen to the right. Tap on
the left white button to set the Date From. Tap on the right
white button to set the Date To. You can press the None
button remove the beginning or end date limit.
Recent Changes date option shows only the transactions
that have been created or modified since the last import or
export. This option is especially useful for users exporting
data to desktop applications such as Quicken or MS
Money who want to avoid importing a lot of duplicate
transactions every time.
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Wildcard searches: % and _ can be used to match
many characters or a single character for the IDS,
Payees, Categories, and Classes fields.
Entering Auto% in the Category field will match
“Auto”, “Auto:Fuel”, “Auto:Taxes” categories
Entering Sm_th in the Payee field will match
“Smith”, “Smyth”, “Smeth” payees.
Entering 104_ in the IDs field would return all
checks between 1040 and 1049.
The filter shown at the right displays all checks
starting with 1 in the current account.
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10. PocketMoney Sync
A video tutorial on how to use PocketMoney Sync from iOS to iOS and iOS to
PocketMoney Desktop (PMD) is available here:
PocketMoney Sync Tutorial
PocketMoney Sync iOS device to Desktop
Assuming that you are just getting started and you have data on your iPhone/iPad that
you want to sync to PMD for the first time.
In PMD:

1. Create a new database in PMD - File > New
2. Start PM Sync - File > Start Sync Server. (PMD will always be the server since it
doesn't have the code to be a client.)
In PM on iOS device:

1. Tap file transfer icon (arrow icon on the account balances screen)
2. Choose PM Sync
3. Set it to Client. (There is no need to buy the Server as an In-App-Purchase since
PMD is acting as the server.)
4. Enter the IP Address of your desktop computer. (In PMD go to Preferences/Options,
then the Synchronization tab, and the IP address is there)
5. Tap Sync.
That is all there is to it for your initial sync. When you Quit PM and launch it the next
time it will reopen the last PM database file you were using.
Subsequent Syncs

In the Preferences/Options of PMD, I recommend you set the Sync Server to start up
when you launch PMD, then all you need to do is run PMD and on your iOS device
Choose PM Sync and tap Sync.
Restoring your data from PMD to iOS device
In the case that you lose your iOS device, or upgrade to a new device, or your spouse
starts using PocketMoney on their phone. You should restore from PMD server.
1. Launch PMD. Start the server if it's not running.
2. On iOS Device tap file transfer icon (arrow icon on the account balances screen)
3. Choose PM Sync
4. Set it to the Client.
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5. Enter the IP Address of your desktop computer. (In PMD go to Preferences/Options,
then the Synchronization tab, and the IP address is there)
6. Turn ON "Restore from Server" - this will delete all your data from PM on your iOS
device before downloading a clean copy from PMD.
7. Tap Sync.
PocketMoney Sync iOS to iOS device
This is much the same as iOS device to PMD. You will be picking one iOS device to be
the server instead of PMD. Decide which device you want to be the server -- it really
doesn't matter all that much, PM Sync is designed so you can sync any number of devices any which way, but the very first time you sync two devices together the server
device should be the device with the most current PM data in it.

In PM on iOS device to be the server:

1. Tap file transfer icon (arrow icon on the account balances screen)
2. Choose PM Sync
3. Set it to Server. (You will need to buy the Sync Server as an In-App-Purchase since
PMD is not acting as the server.)
In PM on iOS device to be the client:

1. Tap file transfer icon (arrow icon on the account balances screen)
2. Choose PM Sync
3. Set it to the Client.
4. Enter the IP Address of the iOS device acting as the server. (The IP address is displayed on the iOS device acting as server.)
5. Turn ON "Restore from Server" - this will delete all your data from PM on your iOS
device before downloading a clean copy from the server device.
6. Tap Sync.

Subsequent Syncs

You can enter data on all of your devices. The only rule is that if you change the same
transaction or account information on both devices, then the last device that was
changed is going to be the data that wins out and will be synced.
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1. On your iOS device to be the server tap file transfer icon (arrow icon on the account
balances screen)
2. Choose PM Sync
3. Set it to Server. (You will need to buy the Sync Server as an In-App-Purchase since
PMD is not acting as the server.)
4. On your iOS device to be the client tap file transfer icon (arrow icon on the account
balances screen)
5. Choose PM Sync
6. Set it to Client.
7. Tap Sync.

Syncing over your cellular data network
Syncing over your cellular data network

11. Wi-Fi Backup, Restore, Import, Export
To access the Wi-Fi File Transfers sheet, tap on the Action Button on the Account List
Screen.
There are two options for uploading and downloading data in PocketMoney. SyncDocs
is small desktop server application, or you can use a web browser. I prefer SyncDocs,
but some users find the web browser is better for them. Go to Prefs > Data Transfers >
Transfer Type to switch between SyncDocs and Web Browser.
SyncDocs
The SyncDocs server is required to be running on your desktop computer (OS X, Windows, or Linux) so PocketMoney can send and receive files. For directions on downloading SyncDocs visit: http://www.catamount.com/SyncDocs.html.
Web Browser Transfer
Many Windows users find the web browser option works better for them because there
are less firewall hassles to deal with using a web browser (Explorer, Safari, Chrome,
Firefox....) than using SyncDocs.
For directions on using the Web Browser, there is a video tutorial here:
WebBrowserTransfers.mov
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Backup to desktop...
Sends the PocketMoneyDB.sql database, the
com.catamount.PocketMoney.plist preferences file,
and any Account Type images to the desktop.
Restore from desktop...
Deletes the current PocketMoney database file and
replaces it with what is received fro the SyncDocs
server. The files backed up above can be restored.
You can also use Restore on PocketMoney for Palm
*.pdb files or Quicken Interchange Format (QIF) files
if you want to replace your current data with what
you are importing.
Import from desktop...
Import PocketMoney for Palm *.pdb files, Quicken
Interchange Format (QIF) files, Open Financial Exchange (OFX/QFX) files, CSV and TDF files. Import
doesnʼt delete the current data so you can merge
pre-existing data. Imported records are matched on the
Account name so the Account name must match exactly.
NOTE: If your desktop software cannot import the file, then it could be a file encoding
issue. Try setting QIF Encoding in PocketMoney Preferences (Under QIF Options) to
Windows or Mac encoding.
Export to desktop...
Sends a Quicken Interchange Format (QIF) file, Comma Separated (CSV) file, Tab Delimited Format (TDF) file to the SyncDocs Server. The QIF file can be imported into
many financial applications. The TDF file can be imported into databases or spreadsheets.
See Filters for details on how to set the Filter to export only Recently Changed transactions.
Exporting QIF files from the main account screen will present you with an additional option sheet for All Transactions
or Recent Changes. Choosing Recent Changes will only
export transactions that have been changed or added since
the last time you exported.
NOTE: Quicken 2005+ dropped support for import certain
types of accounts with QIF files. See this wiki page for the
work around to import the QIF files:
http://en.wikipedia.org/wiki/QIF#Import_Hacks_for_Quicken_2005.2B:_importing_from_
QIF
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Migrating your old PocketMoney for Palm databases
(or the jailbreak version of PocketMoney databases from iPhone 1.x) HotSync your
Palm to so the most recent PocketMoney data is backed up. Then drag and drop the
PocketMoney PDB files to the SyncDocs server window. The PocketMoney PDB files
are located in the /Palm/username/backups/ folder, or you can search for
“PocketMoney-Accounts.pdb”, “PocketMoney-Transactions.pdb”, “PocketMoneyLookups.pdb”. (**The file extension must must lowercase “.pdb” or the files will be sent
to the iPhone, but PocketMoney wonʼt be able to import them.**)

Picking the SyncDocs
Server

local web server

printer settings
After you choose Backup/
Restore/Import/Export,then SyncDocs sever
a browser window will open
for you to pick the SyncDocs Server. In the SyncDocs
Server settings you can name the server whatever
you want. I used the default of “SyncDocs”. Since
SyncDocs uses Bonjour to find the server you might
see other items listed. If you pick a non SyncDocs
server or if you try to connect to an old version of
SyncDocs server then you will get an “invalid server”
error message.
If no SyncDocs server appears, then the most common culprit is there is a firewall turned on somewhere
blocking SyncDocs. Try disabling all your firewalls.
Once you pick the server, then youʼll get a confirmation that the files were uploaded or
downloaded.
*Email Register
In the Transaction Register screen tapping the Action button allows you to email the
transactions currently being displayed.
You have the choice of creating an email with the transactions in QIF, CSV, or TDF format.
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12. Preferences
Adjust your settings, buy add-ons, or modify the popup
lists.
12a. About PocketMoney
This is where you can find the PocketMoney version
number.
12b. Help & Video Tutorials
Sends you to the FAQ on the catamount.com site. The
FAQ contains some of the most frequently asked questions. It also has a link to this documentation and over 90
minutes of video tutorials.
12c. PocketMoney Add-ons
Buy in-app add-ons for PocketMoney. Charts or
PocketMoney Sync.
12d. Security
Set your password and password delay options.
Password: Enter a password if you want PocketMoney to

prompt you to enter a password each time you launch it.
Your password can be of any length.
Tap in the Confirm field and confirm the password you entered in the Password field by reentering it.
If both match then you then the next time you launch
PocketMoney it will ask for your PIN.
To erase the PIN you must delete the PIN in the Password
and Confirm fields.
NOTE: If you forget your password, then you will have to
delete PocketMoney and reinstall it to remove the password.
Delay: Pick a length-of-time to delay the asking of the password. This allows you to quit

the application and relaunch it within a set amount of time. Set Delay to None if you always want it to prompt you for your password.
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12e. Currency
Set your currency and multiple currency options
Home Currency: This defaults to the iPhoneʼs home cur-

rency, but you can change it by tapping on the Home Currency label or > to open the list of currencies.
Multiple Currencies: Turn ON if you are traveling and want

to enter purchases made abroad, or if you need to track
accounts with different currencies
[Extra: I turn multiple currencies on and use it to track my
frequent flier mileage and use it to track billable hours.
The exchange rate for the billable hours is my hourly rate
$50, $150, $250.]
Update exchange rates: Turn ON to have PocketMoney

download the current exchange rates from online whenever PocketMoney is opened. Turn OFF and user will have
to manually update the exchange rate for each account.
Swiss Rounding: Turn ON to use the rounding defaults for the currencies your specify.

Turn OFF to turn off rounding and round to the nearest cent (0.01). This option is designed for users who use CHF - Swiss Franc currency, although it might apply to other
currencies, also. The iPhone default handling of CHF is to round it to the nearest five
cent (0.05, 0.10...) by turning Default Rounding OFF PocketMoney will round to the
nearest cent (0.01, 0.02...).

12f. Data Transfers
Set transfer mode, file encoding, QIF options, and e-mail
partner options.
Transfer Mode: How data is sent back and forth between

PocketMoney and desktop. The options are SyncDocs or
Web Browser.
SyncDocs can run on your desktop at all times

which makes doing quick backups easier, and lets
you drag and drop files into the SyncDocs window
to download them to the iPhone.
Web Browser lets you use any web browser so you

donʼt have to setup additional software. It doesnʼt
require any firewall setting changes. But it is a web
browser so you will have to enter the IP address of
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the iPhone into the browser each time you want to transfer files.
File Encoding: Some common file encoding types used when PocketMoney creates files

to export or tries to read files on import. ISO Latin 1 is the typical Windows encoding.
Mac OS Roman the typical OS X encoding. UTF-8 and UTF-16 are required for character based languages like Japanese. Greek and Russian encodings are also supported.
Note: If you export a CSV file with UTF-16, and try to open it with Excel, then due to
bugs in Excels file handling in some versions you might need to use the File > Import to
import the CSV file instead of double clicking on it to open it.
QIF Options: Set the date and number formats used in

QIF files, set import options, and export options. See the
QIF Options section for details.
Email Partner Options: If you have a wife, husband or sig-

nificant other that you want to keep updated with your current transactions, then turn on Email Updates and enter
their email address. When you Save a Transaction an
email will be generated which you can send send to your
partner. When they receive the email, they click the link in
the e-mail and the transaction will be saved to
PocketMoney on their iPhone.

12g. Display Options
Set UI/Theme options, and other options related to what
is displayed on the screen.
Themes/UI

Themes let you adjust various aspects of the UI from the
color of the UI objects to font size of data.
Row size: Normal rows shows a lot of white-space

giving PocketMoney the look of many iPhone
apps. Short rows allows more data to fit on the
screen at one time.
Binder ring or checkbox: itʼs a personal preference.
Pick what you like better.
Color: Options for Blue, Green, Purple, Gray, and
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Coffee so you can pick a color to suite your financial mood.
Data and Label Font: choices from 14 to 24 point

size and option for normal or bold font.
Red Withdrawals: Turn ON and withdrawals in the

transaction register will be colored in red. Turn OFF
and withdrawals will be colored black. Black withdrawals make it easier to see when the running
balance in your transaction register drops below
the accountʼs limit when the running balance is colored red.
Black Deposits: Some users have a harder time

seeing the default green color for deposits. Turn ON to color deposits black.
Accounts
Options that affect the Account Balances screen.
Summary charts: Display the Net Worth, Cash Flow, or

More Charts view at the top of the Accounts screen.
(Part of the optionally purchased in-app purchase for
Charts.)
Shake to show charts: Turn ON and you can shake your

iPhone to display and hide the summary charts or the
chart on the Reports page. (Part of the optionally purchased in-app purchase for Charts.)
Group by Account Type: Displays a section header for Bank, Cash, Credit Card, Assets,

and Liability account types. The section header subtotals the balance for all of the accounts of that type.
All Transactions: Turn ON to show the All Transactions Custom Row on the Accounts

screen.
Filters: Turn ON to show the Filters Custom Row on the Accounts screen.
Repeating Transactions: Turn ON to show the Repeating Transactions Custom Row on

the Accounts screen.
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Budgets
Options that affect the Budgets screen.
Hide Actual Expenses if 0: Turn ON to hide any budget

expense line item that has a value of zero for the actual
expense.
Show Unbudgeted: Turn ON to show all expenses that

currently do not have a budget amount assigned to
them.
Include Unbudgeted in total: Turn ON to include unbudgeted expense in the over all budget summary total.
Show cents: Turn ON to show cents.
All Accounts: By default Budgets only use the accounts currently displayed on the account balances screen (honoring the Show Accounts - Non-zero or Total Worth setting).
Turn ON to include all accounts in the budget calculations even if they are not being
shown on the accounts screen.
Transaction Register
Options that affect the Transaction Register screen.
ID#: Turn ON to show the ID# in the register row.
Category: Turn ON to show the Category in the register

row.
Memo: Turn ON to show the Memo in the register row.
Class: Turn ON to show the Class in the register row.
Current Balance (Running Balance): Turn ON to show
the running balance under the transaction amount. The
running balance is the current balance in your account as of the time the transaction in
your register. (Note: for several thousand transactions in a single register turning this option OFF will load the the screen faster.)
Foreign Amount: Turn ON to show the amount in the foreign currency as it was entered. Turn OFF to show in the current of the account.
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Edit Transaction
Options that affect the Edit Transaction screen.
On new transactions start editing: Pick which field will be

the active field for new transactions. This will place the
turn in the payee, category, or amount field saving you
the step of tapping in the field yourself.
Calendar Picker: Turn ON to display a 28-31 day calen-

dar. Turn OFF to use Appleʼs date picker. Appleʼs date
picker is better suited if you need to jump back many
months or years at a time. It is also better for visually
impaired users.
Show Time: Turn ON to display the time along with the

date .
Show All Accounts: By default the account list only
uses the accounts currently displayed on the account
balances screen (honoring the Show Accounts - Non-zero
or Total Worth setting). Turn ON to include all accounts in the account popup even if they
are not being shown on the accounts screen.
Show Transfer and Payee: Turn ON to show the Transfer field along with the Payee
field. By default the Payee field is hidden on Transfers, but some desktop applications
use both fields.
Category position: Select where you want the category field positioned on the Edit
Transaction screen.
Show ID, Cleared, Memo, Class: Turn ON to show these fields on the Edit Transaction
screen.
Link ID field in transfers: Turn ON to have the ID field copied to the other half of transfer. This is OFF by default since check numbers are typically associated with only one
half of a transfer.

Reports
Options that affect the Account Balances screen.
Summary charts: Display the Net Worth, Cash Flow, or

More Charts view at the top of the Accounts screen.
(Part of the optionally purchased in-app purchase for
Charts.)
Shake to show charts: Turn ON and you can shake your

iPhone to display and hide the summary charts or the
chart on the Reports page. (Part of the optionally pur-
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chased in-app purchase for Charts.)
Group Subcategories: Includes the amounts of the subcategories in the parent category

and hides the subcategories from the reports. Drill down into the category and rerun the
report to see the breakdown of the subcategories.
Second Balance Line

Turn ON to display two balance amounts in the Balance Bar. You might show the
Cleared Balance and the Current Balance, or the Future Balance and Current Balance.
Red Badge

Displays the red badge on the PocketMoney icon on the Home screen whenever an account exceeds or drops below the Limit defined for an account.

12h. Managed Lists
Edit the Category, Payee, ID, and Class popup lists, and
set options for auto-complete.
Auto-complete transactions: On the Edit Transaction
screen when you start typing in the payee field
PocketMoney searches through your old transaction to try
to find a match. Turn this option OFF if you do not want
PocketMoney auto-completing transactions for you. Japanese, Chinese, Russian, and Korean users might want
this option OFF since this feature doesnʼt work very well
with these languages.
Add new items to lists: Adds Category, Payee, Classes
to the popup lists automatically each time you save a
transaction.
Payees, Categories, Classes, IDs: Delete, rename, and add items to these lists. (See
the section on Lookup Lists for more information.)

12i. Repeating Transactions
Things related to repeating/schedule transactions.
Post Schedule Transactions: Turn ON to have
PocketMoney automatically post repeating transactions to
the account registers on launch. Turn OFF to disable this
feature. You will want to turn this OFF if you are syncing
multiple iOS devices and you only want one device post41
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ing the repeating transactions to the account register – otherwise youʼll have two iPhone
posting transactions and it will cause confusion for you.
Post ___ days in advance: Enter the number of days in advance to add repeating
transactions to the transaction registers.

12j. Miscellaneous
If it didnʼt fit somewhere else itʼs here.
Last saved date for new transactions: Turn ON and
new transactions will use the same date as the last transaction you saved. This can be a time saver if you are entering a lot of old transactions and need to keep opening
the date picker to set the date.
Clear Amount on Autocomplete: When filling in new
transactions using the transaction autocomplete the
amount will be left empty if this option is turned ON.
Clear Splits on Autocomplete: When filling in new
transactions using the transaction autocomplete splits will
be empty if this option is turned ON.
Screen Rotation: Do you want PocketMoney to rotate the screen? Or do you prefer to
keep it portrait mode at all times?
Keyboard Clicks: Turn ON to have the calculator keypad make click sounds when you
press the keys. Turn OFF to disable the click sounds.
Show Tips: PocketMoney shows help dialogs the first time you enter a screen. If you
want to see the help dialogs again then turn this ON.
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13. QIF Options
QIF files can be opened with any text editor to examine
the data. Most of the issues with importing and exporting
are related to the Date or Number formatting being different than the format for your Region of the world. The Defaults should work for most users, but if you have issues
importing or exporting then youʼll need to examine the QIF
file and set the Date and Number formats to match.
File Format
Date Format: mm is months, dd is days, yy or yyyy is two
or four digit years. The one extra special case worth mentioning is mm/ddʼyy – this was the Y2K date format and
Quickenʼs default format.
Date Separator: The forward slash separator shown in
the Date Format can be replaced with a forward slash, period, or dash.
Number Format: The number format that is in the QIF file or that your desktop financial
application is expecting. If you import data and all your amounts are 0, then your number format might be wrong. Open the QIF file and look at the amount lines, then match
up the number format to match what is in the QIF file.
Import Options
Mark All Cleared: If ON then any transaction imported will set Cleared to ON. The rational is if you are importing a QIF from your bank, then your bank already knows about
them and should be cleared. Leave this option OFF if you want to honor the cleared setting in the QIF file.
Import duplicates: If ON, then PocketMoney will import all the transactions in the QIF
file. If you import the same QIF file twice, then youʼll get duplicates. If OFF, then
PocketMoney check to see if the transaction being import already exists and it wonʼt import it twice. Turning this OFF is useful if you download QIF statements from your bank
a couple times a month to update the transactions in PocketMoney. Not foolproof since
if you have two transactions on the same day for the same amount, payee, and category PocketMoney will assume the second one is a duplicate and not import it.
Wipe only transactions on restore: Turn ON if you want to only replace the transactions when you “Restore from Desktop...”. This saves any changes you made to Account Info like setting the icons, the budget info, and other preferences. Turn OFF if you
want Restore to delete everything.
Budgets: Turn ON to import the budget information if it is included in the QIF file.
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Create a File for Each Account: Turn ON if you want a single QIF file created for each
account that is being exported. This is a useful option for users who use MS Money for
their desktop financial application since it only supports QIF files with a single account in
them. Most desktop financial applications can import QIF files that include multiple accounts.

14. Lookup Lists
Lookup Lists are used for Accounts, Categories, Payees, Classes, and IDs. The Lookup
List is accessed by tapping on the field label or the >.

The Category and Payee popups have one additional feature at the bottom of the
screen. Categories and Payees are linked and PocketMoney will show you the Catgegories that have been entered for the current Payee, or the Payees that have been entered for the current Category by default. If you want to see all the Payees or Categories
then tap the “All” button at the bottom of the screen.
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Editing Lookup Lists
Tapping Edit on the Services List Screen will switch to the
editing screen.
Tap the red delete button to delete items (or swipe to delete).
[NOTE: if you are deleting a category, and the category is
linked to a budget, then an alert window will be displayed
prompting you to delete the category only from the budget
or from both the category list and the budget.]
Tap ʻ+ʼ to add a new list item.
Tap on a list item to rename it. An alert window will give
you the option to rename it only in the popup list or everywhere. Everywhere will change it in the popup list and in
all of the transaction records that it occurs in.

15. Miscellaneous
Account List View Options
View Options allows the user to customize the some of the most frequently used options.
Show Accounts: This acts as a global filter on which accounts to use in the Account
popup list in the Edit Transaction Screen, and which accounts to show if All Accounts is
chosen in the Custom Filter screen.
All - Displays all the accounts.
Non Zero - Displays only accounts with a non-zero balance.
Total Worth - Displays only accounts that have the Total Worth checkbox checked. [If
you want to run a report for three specific accounts, then you could set the total worth
flag on for those three accounts, and in the Transaction Register View options for Custom pick All Accounts and it will only use the three total worth accounts you selected.]
Future Balance:
Set the date in the future (or past) used to calculate the value for the Future Balance.
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Transaction Register Reports
Account, Category, Class, Payee Report buttons:
Opens the Report Screen and summarizes the data
based on account, category, class, or payee.
Use Show Custom in the Transactions Register
View Options to customize the data for the reports.
Limit the date range, pick All Accounts to run a report across multiple accounts...
Month by Month is included as part of the Charts
add-ons that is purchased as an in-app-purchase.
(See Reports Screen for more information.)

Transaction Register Tools
File Transfers: Displays another action sheet with
options for transferring your data via email or wi-fi.
(See File Transfers for more information.)
Go to date: Opens a date picker so you can jump to
a specific date. If you pick a date far in the past
(1970), then it will move to the first record. Picking a
date far in the future will move to the last record
(2020).
Adjust Balance: Opens the Adjust Balance Screen.
Enter the correct balance for your account. Pick
whether you want the balance adjusted for just
Cleared Items (if you want your cleared balance to
match a bank statement), or pick All Items if you
want to adjust the overall balance of the account.
Mark transactions cleared: Marks all transactions in the current transaction registered
as Cleared. You can set the filter or use Search to limit what data is displayed in the
transaction register before using Mark All Claered.
Rollup: Rollup deletes all of the transactions currently shown in the transaction register
and replaces them with one transaction. It keeps the sum of the amounts and the categories of deleted transactions so the balance of the account stays correct and keeps the
categories so you can run reports while maintaining some historical category informa-
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tion. Rollup will create two transactions if cleared transactions get rolled up so it has one
cleared and one uncleared rolled up transaction.
Use rollups to delete old data that you no longer want around. You might rollup data for
the previous year after you do your taxes. PocketMoney can handle large amounts of
data so I never rollup my data because I like to keep all my data with me.
Video Tutorial: “Rollups”

Transaction Register View Options
View Options lets you adjust how the data is sorted. (Less
frequently used view options can be found in the Prefs >
Display Options > Transactions.)
Sort on: Which field to sort the transaction register by.
The choices available are Amount, Category, Class,
Cleared, Date, ID#, Memo, and Payee.
Sort order: Ascending Date - If you like the newest transaction at the bottom of the
screen like a traditional checkbook.
Descending Date - If you like the newest transaction at the top of the screen.

Date Picker
Tapping on the Date field will use the date picker shown.
Tap on a day on the calendar to pick a date and close the
date picker.
Tapping on the time lets you set the time.
Tapping the Today button will select the current date and
time and close the picker
Tapping the < > left and right arrows will move you to the
next or previous month.
Set Show Time ON/OFF in Prefs > Display Options > Edit
Transaction if you need the ability to set a specific time with your transactions – for instance if you are tracking billable hours.
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Exchange Rate Worksheet
The Exchange Rate Worksheet is accessed from
tapping on the Amount label or > on the Edit Transaction Screen. Multiple Currencies must be ON in
PocketMoney Preferences.
Tapping on the Foreign Amount label or > will open
up the Currency Picker. If there is an internet connection available, then PocketMoney will lookup the
current exchange rate for the currency you select
and enter it into the Exchange Rate field.
1/x will invert the Exchange Rate amount.
Depending on the order in which you edit the Foreign
Amount, Exchange Rate, and Account Amount field
PocketMoney will calculate the appropriate value for
the other fields.

Installing Custom Icons
PocketMoney installs dozens of Account Type icons for
you by default, but you can create and install your own,
also.

The icon should be 30x30 pixels.
The type of the icon needs to be either png, jpg, or gif.
Once you create the icon, then you can use the “Import
from desktop...” option in the Action Button to send the
icons from the SyncDocs Server over Wi-Fi to install into
PocketMoney on the iPhone.
The icons you download into PocketMoney will be listed
first in the icon picker.

16. Video Tutorials
Iʼve put together several video tutorials on using different aspects of PocketMoney.
Some users like written directions and others like videos.
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PocketMoney Video Tutorials
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Calendar Picker
The calendar picker is based on code from Tree House Ideas.
Copyright (c) 2006, Tree House Ideas
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Tree
House Ideas nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission. THIS
SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

49

